The proposed Mechanistic-Empirical Pavement Design Guide (MEPDG) greatly increases the complexity of characterizing traffic inputs for pavement design and introduces new traffic data analysis requirements to State and local highway agencies. In the past, designers simply input traffic volumes, percent heavy trucks, and a typical loading factor. The MEPDG requires the use of axle weight data in the form of axle load distributions, commonly referred to as axle load spectra, for each vehicle class collected by weigh-in-motion (WIM) devices. These new data requirements and formats require enhanced data processing tools.

To address MEPDG data requirements, Applied Research Associates, Inc. (ARA), developed a prototype software product, called Advanced Traffic Loading Analysis System (ATLAS), to process, store, and analyze traffic data and to generate traffic input files for the MEPDG software. MS-ATLAS, Mississippi Advanced Traffic Loading Analysis System, was developed under this study to enhance and customize the ATLAS software to the Mississippi traffic data and conditions.

MS-ATLAS contains four main modules:

- Automated Traffic Recorder (ATR) Data Processing
- Traffic Data Analysis
- Traffic Library Exploration
- Generate MEPDG Inputs

Benefits of implementing MS-ATLAS include cost-effective and easier manipulation of traffic data to support MEPDG and traffic data analysis capabilities.
# TABLE OF CONTENTS

INTRODUCTION .......................................................................................................................... 1  
  Background................................................................................................................................. 1  
  Acknowledgement ...................................................................................................................... 1  
  MS-ATLAS Overview ................................................................................................................ 1  
Getting Started ................................................................................................................................ 4  
  System Requirements .................................................................................................................. 4  
  Software Installation and Removal ............................................................................................. 4  
  Starting MS-ATLAS ................................................................................................................... 5  
  Using the Menus and Toolbars ................................................................................................... 5  
ATR DATA PROCESSING MODULE ......................................................................................... 7  
  Start Data Processing ................................................................................................................ 7  
  Import Traffic Files from ATR Sites ........................................................................................... 8  
Traffic Data ANALYSIS MODULE ............................................................................................ 10  
  Analysis Levels ......................................................................................................................... 10  
  Traffic Data Analysis Module Overview ................................................................................ 10  
  Start Traffic Analysis .............................................................................................................. 12  
  Select ATR Site and Analysis Level ......................................................................................... 13  
  Select Traffic Library Sites to Support Analysis (Levels 2 and 3 Only) .................................. 14  
  Step 1: Create Normalized Vehicle Class Distribution ............................................................. 15  
  Step 2: Create Normalized Axle Load Spectra by Class. ......................................................... 18  
  Step 3: Create Axle Per Class Coefficients ............................................................................. 21  
  Step 4: Determine Base Truck Volume and Annual Growth. .................................................. 23  
  Step 5: Create Monthly Adjustment Coefficients ................................................................. 24  
  Step 6: Create Hourly Distribution Factors. ............................................................................. 26  
  Step 7: View Estimated Design ESALs and Select Output Options. ....................................... 27  
  Run Analysis .......................................................................................................................... 29  
Traffic Library EXPLORATION MODULE ............................................................................... 31  
  Select ATR Sites or Regional Defaults Using Filters ............................................................... 32  
  Select ATR Sites using MS Map Exploration .......................................................................... 43  
GENERATE MEPDG INPUTS ................................................................................................... 45  
  View Traffic Characteristics and Generate MEPDG Inputs .................................................... 49  
  Establish Base Year Truck Volume and Growth ..................................................................... 54  
  View Estimated ESALs and Generate MEPDG Input Files .................................................... 55
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>MS ATLAS Data Management Tool Suite</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>MS-ATLAS Start Screen</td>
<td>5</td>
</tr>
<tr>
<td>3</td>
<td>ATR Data Processing Module</td>
<td>7</td>
</tr>
<tr>
<td>4</td>
<td>Input Traffic Files Screen</td>
<td>8</td>
</tr>
<tr>
<td>5</td>
<td>View or Update Site Information</td>
<td>9</td>
</tr>
<tr>
<td>6</td>
<td>Traffic Data Analysis Module</td>
<td>11</td>
</tr>
<tr>
<td>7</td>
<td>Traffic Analysis Screen</td>
<td>13</td>
</tr>
<tr>
<td>8</td>
<td>Traffic Site and Analysis Selection Screen</td>
<td>14</td>
</tr>
<tr>
<td>9</td>
<td>Processed ATR Site Selection Screen</td>
<td>15</td>
</tr>
<tr>
<td>10</td>
<td>Normalized Vehicle Class Distribution for Level 1 or 2 Analysis</td>
<td>16</td>
</tr>
<tr>
<td>11</td>
<td>Normalized Vehicle Class Distribution for Level 3 Analysis</td>
<td>17</td>
</tr>
<tr>
<td>12</td>
<td>Normalized Load Spectrum for Months with WIM Data, Level 1 Analysis</td>
<td>19</td>
</tr>
<tr>
<td>13</td>
<td>Normalized Load Spectrum for Months without WIM Data, Level 1 Analysis</td>
<td>20</td>
</tr>
<tr>
<td>14</td>
<td>Normalized Load Spectrum for Level 2 or 3 Analysis</td>
<td>21</td>
</tr>
<tr>
<td>15</td>
<td>Axle per Class Coefficients for Level 1 Analysis</td>
<td>22</td>
</tr>
<tr>
<td>16</td>
<td>Axle per Class Coefficients for Level 2 and 3 Analysis</td>
<td>23</td>
</tr>
<tr>
<td>17</td>
<td>Truck Volume and Annual Growth</td>
<td>24</td>
</tr>
<tr>
<td>18</td>
<td>Monthly Adjustment Coefficients for Level 1 or 2</td>
<td>25</td>
</tr>
<tr>
<td>19</td>
<td>Monthly Adjustment Coefficients for Level 3 Analysis</td>
<td>26</td>
</tr>
<tr>
<td>20</td>
<td>Hourly Distribution Factors</td>
<td>27</td>
</tr>
<tr>
<td>21</td>
<td>Design ESALs and Output Options</td>
<td>28</td>
</tr>
<tr>
<td>22</td>
<td>Updated Traffic Site Selection Form</td>
<td>29</td>
</tr>
<tr>
<td>23</td>
<td>Run Traffic Analysis Screen</td>
<td>30</td>
</tr>
<tr>
<td>24</td>
<td>Traffic Library Exploration Module</td>
<td>31</td>
</tr>
<tr>
<td>25</td>
<td>Select Traffic Exploration Method</td>
<td>32</td>
</tr>
<tr>
<td>26</td>
<td>ATR Sites or Defaults for Traffic Exploration</td>
<td>33</td>
</tr>
<tr>
<td>27</td>
<td>Map of ATR Sites</td>
<td>34</td>
</tr>
<tr>
<td>28</td>
<td>Site Specific Traffic Information</td>
<td>35</td>
</tr>
<tr>
<td>29</td>
<td>Vehicle Class Tab</td>
<td>36</td>
</tr>
<tr>
<td>30</td>
<td>Normalized Single Axle Load Distribution</td>
<td>37</td>
</tr>
<tr>
<td>31</td>
<td>Normalized Tandem Axle Load Distribution</td>
<td>38</td>
</tr>
<tr>
<td>32</td>
<td>Normalized Tridem Axle Load Distribution</td>
<td>39</td>
</tr>
<tr>
<td>33</td>
<td>Axle Coefficients</td>
<td>40</td>
</tr>
<tr>
<td>34</td>
<td>Monthly Truck Volume Adjustment Factor</td>
<td>41</td>
</tr>
<tr>
<td>35</td>
<td>Hourly Truck Volume Distribution Factor</td>
<td>42</td>
</tr>
<tr>
<td>36</td>
<td>Explore Traffic Defaults</td>
<td>43</td>
</tr>
<tr>
<td>37</td>
<td>Select ATR Sites from Map</td>
<td>44</td>
</tr>
<tr>
<td>38</td>
<td>Generate MEPDG Inputs</td>
<td>45</td>
</tr>
<tr>
<td>39</td>
<td>Create or Select a Project to Generate MEPDG Traffic Inputs</td>
<td>46</td>
</tr>
<tr>
<td>40</td>
<td>Create a New Project to Generate ME- PDG Inputs</td>
<td>47</td>
</tr>
<tr>
<td>41</td>
<td>Select a Surrogate ATR Station to Generate MEPDG Inputs</td>
<td>48</td>
</tr>
<tr>
<td>42</td>
<td>Select a Regional Traffic Default to Generate ME- PDG Inputs</td>
<td>49</td>
</tr>
<tr>
<td>43</td>
<td>Specific ATR Site Information</td>
<td>50</td>
</tr>
</tbody>
</table>
INTRODUCTION

Background

The proposed Mechanistic-Empirical Pavement Design Guide (MEPDG) greatly increases the complexity of characterizing the traffic inputs for pavement design and introduces new traffic data analysis requirements to State and local highway agencies. In the past, designers simply input traffic volumes, percent heavy trucks, and a typical loading factor. The MEPDG requires the use of axle weight data in the form of axle load distributions, commonly referred to as axle load spectra for each vehicle class that are collected by weigh-in-motion (WIM) devices. These new data requirements and formats require enhanced data processing tools.

Acknowledgement

To address MEPDG data requirements, Applied Research Associates, Inc. (ARA), developed a prototype software product, called Advanced Traffic Loading Analysis System (ATLAS), to process, store, and analyze traffic data and to generate traffic input files for MEPDG software.

MS-ATLAS, Mississippi Advanced Traffic Loading Analysis System, was developed under Mississippi State Study No. 188 to enhance and customize the ATLAS software to the Mississippi traffic data and conditions. Ms. Yan Jane Jiang, P.E., was the main developer of MS-ATLAS. Dr. Athar Saeed, P.E., served as the Principal Investigator for the project, and Mr. William Barstis, P.E., was the Mississippi Department of Transportation (MDOT) Project Monitor. Ms. Lester Rabe developed the installation package.

MS-ATLAS Overview

MS-ATLAS contains four main modules, as shown in Figure 1.

- Automated Traffic Recorder (ATR) Data Processing
- Traffic Data Analysis
- Traffic Library Exploration
- Generate MEPDG Inputs
INTEGRATED TRAFFIC DATA MANAGEMENT SYSTEM TOOL SUITE

Figure 1. MS ATLAS Data Management Tool Suite

ATR DATA PROCESSING

This module imports an agency’s Automated Traffic Recorder (ATR) data in ASCII formats, passes through preset quality control (QC) rules, computes basic traffic volume statistics such as average annual daily truck traffic (AADTT), and stores the data in the MS-ATLAS database. The program reads standard Federal Highway Administration (FHWA) Traffic Monitoring Guide (TMG) ATR data formats for automated vehicle classifiers (AVC) and WIM sensors, namely W-Card, C-Card from the 3rd version of TMG, or 7-Card and 4-Card from the 2nd version of TMG.

TRAFFIC DATA ANALYSIS

This module analyzes the processed ATR data and produces the traffic data elements in response to the MEPDG requirements. In addition, estimated cumulative equivalent single axle loads (ESALs) are computed for the preset pavement analysis period, as a reference to the analyst. The following are the major steps contained in this module:

Step 1. Normalized Vehicle Class Distribution
Step 2. Normalized Axle Load Spectra by Class
Step 3. Axle per Class Coefficients
Step 4. Base Truck Volume and Annual Growth
Step 5. Monthly Truck Volume Adjustment Coefficients
Step 6. Hourly Truck Volume Distribution
Step 7. View Estimated ESALs and Select Output Options

TRAFFIC LIBRARY EXPLORATION

As ATR traffic data are processed over time, the user may choose to export high-quality analysis outputs from the traffic data analysis module into an interactive traffic library. This module
enables users to explore the traffic data library, either by user-set filters or through a geographic information system (GIS) enabled map.

GENERATE MEPDG INPUTS

This module allows the user to select either a surrogate ATR site or a regional default, then generate the traffic input files required by the MEPDG software.
GETTING STARTED

System Requirements

The following are minimum hardware and software requirements for installing and running MS-ATLAS:

• IBM-compatible Pentium processor
• 512 MB of RAM
• 512 MB of available hard disk space
• A CD-ROM drive
• Super video graphics adapter with at least 1024*768 pixels resolution and 256 colors
• Microsoft mouse or compatible pointing device
• Windows 2000 or XP operating system
• The installer will require the user to have Administrative privilege on the local machine to install the package

Software Installation and Removal

To install MS-ATLAS:

1. Make sure that all other applications are closed and that the MS-ATLAS installation CD-ROM has been inserted into the CD-ROM drive.
2. From the Windows Start menu, select Run.
3. In the Run dialog box, type (cd drive):setup.exe, where (cd drive) is the letter assigned to your CD-ROM drive.
4. Follow the simple instructions in the installation program.
5. When installation is completed successfully, MS-ATLAS will be available from the Start menu.

To remove MS-ATLAS:

1. Click the Start button and choose the Settings option.
2. Select Control Panel.
3. From the Control Panel, double-click on the Add/Remove Programs icon.
4. Once within that dialog box, click on the Install/Uninstall tab.
5. Select MS-ATLAS from the list of programs, then click on the Add/Remove button.
6. A final warning will ask if the user want to delete MS-ATLAS from your computer. If this is the case, click Yes to remove all MS-ATLAS files.
Starting MS-ATLAS

When the user opens MS-ATLAS, the toolbox selection window appears on the screen, as shown in Figure 2. Select one of the tools or modules by clicking on a radio button. For example, select the button for TRAFFIC DATA ANALYSIS. Once a radio button is selected, click on the Start button to begin analysis.

The user may also click the Compact Analysis Database button to compact the MS-ATLAS analysis database that houses all the processed traffic monitoring data.

Using the Menus and Toolbars

There are four sets of menus in the MS-ATLAS software: Tools, View, Window, and Help.
Tools Menu

The Tools menu provides access to the main MS-ATLAS modules or tools, namely:

- Generate MEPDG Inputs
- Explore Traffic Data Library
- Process ATR Data
- Analyze ATR Data

Click one of these menu items to access the corresponding module, or click Exit to leave the MS-ATLAS software.

View Menu

The View menu includes the option to display or hide two items:

- Toolbar: The row of icons below the menus
- Status Bar: Shows the file name, date, and time at the bottom of the MS-ATLAS window

If the View menu shows a checkmark next to the item, it is selected for display. Click on an item’s name to remove it from your screen.

Window Menu

The Window menu contains functions that allow the user to better arrange the screen:

- Cascade: Arranges all of the windows by resizing and stacking them on top of each other in a cascading fashion
- Tile Horizontal: Resizes and tiles all the windows horizontally
- Tile Vertical: Resizes and tiles all the windows vertically

Below these three options the user will see the names of the open MS-ATLAS windows. The active window is designated with a checkmark. To change the active window, click on the name of the window the user wish to activate.

Help Menu

About MS-ATLAS provides basic information about MS-ATLAS. The MS-ATLAS User’s Guide is accessible from Windows’ Start Menu, along with the MS-ATLAS program icon group.

Toolbar Buttons

The toolbar provides convenient shortcuts to the main MS-ATLAS modules. If the user rest the pointer on a toolbar button for a few seconds, a description of the toolbar button will appear.
**ATR DATA PROCESSING MODULE**

This module, shown in Figure 3, is the foundation of the MS-ATLAS software because all other modules build on the data processed in this module. The module is capable of importing several popular traffic monitoring file formats as defined in two versions of the FHWA TMG. The following file formats are in accordance with the 3rd version of the FHWA TMG (2001):

- **W-card** – The Truck Weight file contains one record for each truck with its axle weights and axle spacings.
- **C-card** – The Vehicle Classification file contains one record for each hour with the traffic volume by vehicle class.

To account for the following other file formats, MS-ATLAS also works with the 2nd version of the FHWA TMG (1992):

- **7-card** – Weight records
- **4-card** – Vehicle classification records

### Start Data Processing

To start the data processing module, the user may either select the *ATR DATA PROCESSING* radio button from the toolbox selection screen and then click *Start*, or click the corresponding tool button, or select the module from the *Tools* menu.
Import Traffic Files from ATR Sites

When the *Import Traffic Files from ATR Sites* form, shown in Figure 4, appears on the screen, follow these steps to import and process ATR data files:

1. Select the traffic data file format type.
2. Select the directory where the raw files are located.
3. Select files names to process from the list.
4. Click on the *Import the Selected Files* button to begin import and processing.

As data processing is progressing, the processed traffic site IDs are added to the imported traffic sites list on the left side of the form. The processed data are then saved in the database tables listed in the middle portion of the form. The color-coded icons in the left and middle portions of the form show the status of data processing and database table updates, respectively.

![Figure 4. Input Traffic Files Screen.](image-url)
If data problems were encountered during data processing, these problems will be written to the corresponding error log file `Error_log_WIM.txt` for weight data and `Error_log_AVC.txt` for vehicle classification data. In this case, the user will be prompted to review the error log file at the end of the data processing session. The error log file is located in the same directory as the raw files that have been processed. Data lines or files with errors will not be imported or counted by ATLAS. If no data problems are encountered during the data processing, a message will appear informing the user that the files were processed successfully.

To view and update the various site, traffic, and equipment characteristics of the processed data, click the View or Update ATR Site info button in Figure 4. The following form will appear and can be updated by the user with the appropriate information (Figure 5).

![View or Update ATR Site Information](image)

**Figure 5. View or Update Site Information**

The view or update site information screen can be accessed at anytime by returning to the traffic processing module. Once all updates are complete, click the Update Site info button near the bottom of the form to update the ATR site information. If there are no updates to be made, click the Close button to close the form and return to the Input Traffic Files screen.
TRAFFIC DATA ANALYSIS MODULE

The traffic data analysis module is the most comprehensive and core module that analyzes the imported traffic monitoring data to satisfy all the traffic inputs required of the MEPDG. All historical traffic data for the site should be processed using the *ATR Data Processing* tool before conducting traffic data analysis.

Analysis Levels

The user may select different traffic data analysis levels, depending on the following utilization of traffic data:

- Level 1 – Analysis is based on site-specific axle weight, vehicle class, and truck volume data collected at WIM stations.
- Level 2 – Analysis is based on site-specific vehicle class and truck volume data collected by AVC stations, and axle weight distributions from other traffic monitoring sites with similar truck traffic characteristics.
- Level 3 – Analysis is based on site-specific truck volume data and vehicle class and axle weight distributions from selected sites with similar truck traffic characteristics.

MS-ATLAS automatically selects the highest level of analysis available, based on site traffic data records.

Traffic Data Analysis Module Overview

The traffic data analysis module, as illustrated in Figure 6, consists of two main parts in performing traffic data analysis for any ATR site:

Part 1 – Select an ATR Site, as well as supporting traffic library sites or defaults
Part 2 – Perform a step-by-step analysis for each site and selected analysis level
There are seven major steps in traffic data analysis, as described below. Steps 1 through 6 are designed to analyze traffic data and create specific input files as required the MEPDG software.
Step 7 allows the user to set the output options and to view computed Equivalent Single Axle Loads (ESALs).

Step 1. Normalized Vehicle Class Distribution – This step creates normalized vehicle class distribution factors, as defined by the FHWA vehicle classification system. The program stores the derived normalized vehicle class distribution factors in its database, in preparation of generating MEPDG vehicle classification factor file.

Step 2. Normalized Axle Load Spectra by Class – This step analyzes the weight distribution data, by month and for each vehicle class.

Step 3. Axle per Class Coefficients – This step computes the average number of axles per truck coefficients for each axle type and vehicle class combination.

Step 4. Base Truck Volume and Annual Growth – This step estimates the truck volume, i.e. AADTT and related construction parameters for the estimated traffic open year. In addition, annual truck growth is established for the pavement design or analysis period.

Step 5. Monthly Truck Volume Adjustment Coefficients – This step allows the user to view the monthly truck volume adjustment coefficients computed from ATR data. The user may choose to modify these coefficients if necessary.

Step 6. Hourly Truck Volume Distribution – This step displays the computed hourly distribution factors. Again, the user may revise the distribution factors as needed.

Step 7. View Estimated ESALs and Select Output Options – This step computes the estimated cumulative ESALs over the design period, either on a standard or a user defined pavement structure. It also allows the user to set output options for the analyzed traffic data.

The following sections provide detail descriptions of the actions for analyzing traffic data.

Start Traffic Analysis

Select the Analyze ATR Data tool and click on the Start button on the toolbox selection screen, or Analyze ATR Data from the toolbar/menu. Next, select a site for analysis. To bring up the traffic site selection screen, click on the red square icon next to the Available traffic sites caption, shown in Figure 7. Note that the Run Analysis button will be disabled until site selections are made.
Figure 7. Traffic Analysis Screen.

**Note:** All color-coded selections initially have a little red square icon next to them. Once the selection is made, the icon color changes to yellow if intermediate steps are required, or green to indicate that all required steps have been completed.

**Select ATR Site and Analysis Level**

The traffic site selection form contains a list of sites with historical data available for analysis. To perform the analysis, a site ID must be selected. Click on a site ID to see the general information about the site displayed on the right side of the form. Then choose the level of analysis to be performed. Once site and analysis level are selected, click on the *Select* button.

The screen shown below (Figure 8) also allows the user to *Remove* an ATR site and its associated traffic from the analysis database. This feature is useful for removing previously processed traffic data that are later deemed inaccurate. It also helps to reduce the size of the analysis database.
For Level 1 analysis: after the user click on the Select button, the data analysis steps become visible on the Traffic Loading Data Analysis form. Each step is represented by a red icon. Click on each icon to select traffic variables for analysis and to specify analysis output options.

For Level 2 or Level 3 analysis: after the user clicks on Select button, the Select Traffic Library Sites to Support Analysis form appears.

**Select Traffic Library Sites to Support Analysis (Levels 2 and 3 Only)**

This form, shown below in Figure 9, has a number of filters designed to help identify sites with axle loading data that have traffic characteristics similar to the analysis site. The user may change or select any number of filter criteria. Once all filters are specified, select the sites to be used in the analysis and click on the Start Analysis button.
Step 1. Create Normalized Vehicle Class Distribution.

For Analysis Level 1 or 2

For this step, the user may select Process to derive normalized vehicle class distribution from the traffic monitoring data, or Compare w/TTCs to QA review the resulting normalized vehicle class distribution.

For the years with historical vehicle classification data, the program computes an average annual vehicle class distribution based on available historical years of data by default. The resulting vehicle class distribution is displayed as “Stored” on the screen. The user may choose to recompute the default vehicle distribution by selecting or deseleting historical years used in computation of average vehicle class distribution, then clicking on the Record/Update button.

The program automatically matches the vehicle class distribution to the Truck Traffic Classification (TTC) groups, as defined in the MEPDG.
Select which years to use in the analysis by double clicking on the checkmark, shown in Figure 10 above. Once the review and/or updates are completed, click on the Next button. The square icon next to step 1 will change to green, and the icon next to step 2 will change to yellow.

For Analysis Level 3

Normalized vehicle class distributions for the sites selected from the traffic reference library are displayed for review and selection for computation of vehicle class distribution for the analysis site. In addition to the reference sites, the computed average (based on all reference sites) normalized vehicle class distribution is displayed on the screen as “Computed,” and normalized vehicle class distribution from previous analysis of this site (if applicable) is displayed as “Stored”. The user can choose not to display the computed and stored values and/or choose to display different MEPDG TTC’s by using the display options portion of the form. Furthermore, the user can select and deselect the traffic sites to be used in the analysis by double-clicking on the sites listed under Library sites available, shown below in Figure 11. A checkmark next to the site indicates that the site is selected.
Figure 11. Normalized Vehicle Class Distribution for Level 3 Analysis.

Once updates are completed, click the Next button.
Step 2: Create Normalized Axle Load Spectra by Class.

For Analysis Level 1

**Analysis Mode.** The user may select either *Process* to analyze axle load data for each month or *View processed results by months* to view the resulting axle load spectra for each month, each vehicle class, and axle type. By default, the *Process* radio button is on as seen in Figure 12.

The form has four tabs design to assist in reviewing single, tandem, tridem, and quad axle load spectra for analysis. Based on traffic data availability, the user may have up to 12 months of historical traffic monitoring data. Each month may have data from one or more year.

**Months with WIM data.** The program computes average load spectra based on available historical data for each month and each vehicle class. The resulting spectra are displayed as “Stored” on the screen, as shown in Figure 12. The user may choose to review and/or re-compute the axle load spectra for selected months or vehicle classes by using the following steps:

1. Select the month from the drop-down box in the top-right corner of the screen.
2. Select the vehicle class from the drop-down box at the bottom of the screen.
3. Remove checkmarks from the historical years that will not be used in the analysis by double-clicking on the years.
4. Click the *Record/Update* button in the lower right corner of the screen to update default spectra for selected month and vehicle class.

*Apply selection to processing months* – To apply the current analysis year selection to all the processing months, select the *All* option.

*Apply selection to vehicle classes* – To apply the current analysis year selection to all vehicle classes, select the *All* option.

*Assigned TWRG Group* – Based on reviewing the shapes of the axle load spectra, the user may choose to assign a Truck Weight Road Group (TWRG), as defined in the 3rd version of FHWA TMG (2001).
Months without WIM data. The program computes average load spectra based on the spectra from the months containing historical data for each vehicle class. The resulting spectra are displayed as “Stored” on the screen, as shown in Figure 13. The user may choose to review and re-compute the default spectra for the selected months or vehicle classes by using the following steps:

1. Select the Months without WIM data option displayed in the top right corner of the screen shown in Figure 13.
2. Select the month from the drop-down box in the top-right corner of the screen.
3. Select the vehicle class from the drop-down box at the bottom of the screen.
4. Remove checkmarks from the historical months that will not be used in the analysis by double-clicking on the month.
5. Click the Record/Update button in the lower right corner of the screen to update default spectra for selected month and vehicle class.
Once all the review and updates are completed for single, tandem, tridem, and quad axle groups, click on the *Next* button.

**For Analysis Level 2 or 3**

This form has four tabs designed to assist in reviewing and selecting single, tandem, tridem, and quad axle load spectra using the sites selected from the traffic reference library. Normalized load spectra for the selected WIM reference sites from the traffic reference library are displayed for user review and selection for computation of load spectra for the analysis site.
The user may select or deselect some of the reference sites for computation of axle load spectra by double-clicking on the site ID in the box on the right side of the form as shown above in Figure 14. To see the updated results, click the Record/Update button. In addition to the reference sites, the computed average (based on all reference sites) normalized load spectra can be displayed, along with the stored values, by selecting the Show Computed/Stored display option. The MEPDG defaults can also be displayed on the screen by selecting the Show MEPDG Defaults display option. Furthermore, the user can view or assign a TWRG using the pull-down menu at the top of the form.

Once site selections are finalized, click on the Record/Update button to compute new average load spectra based on selected sites. The new spectra can be computed either for a selected vehicle class or for all vehicle classes using the pull-down menu for FHWA Vehicle Class on the left-hand side of the form.

**Step 3: Create Axle Per Class Coefficients.**

**For Analysis Level 1**

By default, for the years with historical vehicle classification and axle weight data, the program computes average axle per class coefficients based on all available data. The resulting
coefficients are displayed in the table on the form as shown in Figure 15. The user may choose to change the default coefficients by typing new values in the table, then clicking on the *Update* button. To go back to the original default coefficients, click on the *Re-Load* button. Once the review and/or updates are completed, click on the *Next* button.

![Step3: Create Axle Per Class Coefficients](image)

**Figure 15.** Axle per Class Coefficients for Level 1 Analysis.

**For Analysis Level 2 or 3**

By default, average axle per class coefficients are computed based on the library sites used in the load spectra selection. The resulting coefficients are displayed in the table on the form shown below in Figure 16. If the user wants to keep the default coefficients, the *Use National Default* radio button should be selected; if not, then the *Computed from selected sites* radio button should be selected, and the user should select which traffic sites to use in the calculation. The traffic sites that will be used to calculate the coefficients are selected when there is a checkmark besides the site. The sites can be selected or deselected by double-clicking the checkmarks next to each site. Furthermore, the user may change these coefficients manually by typing new values into the table. Once satisfied with the coefficients, click the *Update* button to store the results.
Step 4: Determine Base Truck Volume and Annual Growth.

By default, the program computes base year AADTT as an average of AADTTs from all available historical years. The resulting base year AADTT and historical years used for its computation are displayed on the form. The user may choose to change the assigned two-way AADTT information on this form by overwriting the values in the text boxes on the right as seen in Figure 17. Furthermore, the user may choose to update/change the growth function and growth rate using the left-hand side of the form. If the historic growth rate is not available, the program will assume that the growth function is linear and apply a default growth rate of 4%. The program also assigns a default value of 50% for the trucks in the design direction, and a value of 90% for the trucks in the design lane. The user can choose to use the default values, or overwrite the default values.

Other general pavement design data such as the number of lanes in design direction, operational speed, design, traffic open year and month, are also specified in this form.

Vehicle-class specific traffic growth – The user has the option to assign different growth function and growth rate for each vehicle class, or the same growth function and rate for all the vehicle classes.
After making adjustments to the form, click the Update/Record button to record new information to the database. Once the review and/or updates are completed, click on the Next button.

**Step 5: Create Monthly Adjustment Coefficients.**

For Analysis Level 1 or 2

By default, the program computes and stores monthly coefficients based on year(s) with maximum number of months with data. The resulting monthly coefficients and historical years used for their computation are displayed on the form as seen in Figure 18. The user may choose to change the default coefficients by selecting different years with monthly data or by typing new coefficients in the table at the bottom of the form and clicking on the Record Results button.

The user can update/change monthly coefficients for all vehicle classes or only for selected classes by selecting the Vehicle Class option from the drop-down box on the left side of the form.

If the user does not want to consider monthly truck volume variation in the analysis, put a checkmark next to the No monthly variation option shown on the left side of the form.
Figure 18. Monthly Adjustment Coefficients for Level 1 or 2.

Once the review and/or updates are completed, click on the Next button.

For Analysis Level 3

By default, the program assumes no variation, assigning each month a coefficient of 1 (See Figure 19).
The user can overwrite the default coefficients by typing in an appropriate coefficient for each month. Furthermore, the user can choose to apply different coefficients to each FHWA vehicle class or apply the same coefficient to all classes. If new coefficients are desired, update the coefficients for each month and click the Re-Plot button to display the results. Once satisfied with the results, click the Record Results button to store the new coefficients.

Once the review and/or updates are completed and the results are stored, click the Next button.

**Step 6: Create Hourly Distribution Factors.**

By default, the program computes and stores hourly distribution factors based on all available historical years with hourly data. The resulting monthly hourly distribution factors are displayed on the form as “Stored,” as shown in Figure 20 below.
Figure 20. Hourly Distribution Factors.

The user can change the default hourly distribution factors by typing new coefficients in the table at the bottom of the form. Clicking on the Update Chart button will display new coefficients graphically as “Current.” The user can update the results by clicking on the Record the new factors button. To go back to the original default coefficients, click on the Reset button.

Once the review and/or updates are completed for the hourly distribution factors, click on the Next button.

Step 7: View Estimated Design ESALs and Select Output Options.

The user may overwrite the default values for the AC Structural Number, PCC Depth, and/or the Terminal Serviceability Index by typing over the default values in the text boxes on the left-hand side of the form (Figure 21). After all updates have been made, click the Re-compute ESALs button and move to the bottom part of the form to select output options.

Regardless of the user selection of output options, analysis results will be stored in the analysis database tables, so that the results will be available the next time the user selects the same site for analysis.
In addition, the user may choose to create external MEPDG traffic files and/or update traffic library files with the data for the selected site. The library traffic files are used for Level 2 and Level 3 analyses for the sites with limited site-specific data. Furthermore, the data can be saved as a regional default and can then be used in future applications when traffic data at a specific site within that particular region are limited.

Select output options by checking the appropriate boxes and click OK.

![Figure 21. Design ESALs and Output Options.](image)

After the seven analysis steps are completed ATLAS will update and store the average TTC group, average ESAL per truck, and the two way AADT in the traffic characteristics section of the site selection form (Figure 22).
Run Analysis

Once all seven analysis steps are completed, the Run Analysis button becomes enabled (Figure 23). The database tables and external output files that will be created when the user clicks the Run Analysis button are shown in the middle section of the form.

Select the desired output file directory using the drop-down box and directory tree in the lower right corner of the screen. External files will be saved to a new or existing directory that has the same name as the Site ID shown in the right upper corner of the form.
Figure 23. Run Traffic Analysis Screen
TRAFFIC LIBRARY EXPLORATION MODULE

The exploration module provides access to the processed quality traffic data and benchmark library information and is shown below in Figure 24.

There are three options to start exploring the data:

- Upon starting the MS-ATLAS program, the user may either click on the EXPLORE TRAFFIC DATA LIBRARY tool and then click on the Start button, or
- During any session of the MS-ATLAS program, click the corresponding tool button, or
- Select the module from the Tools menu.

The traffic data can be accessed by using selection criteria filters or by selecting traffic sites from the Mississippi map. To make a selection, click on one of the two exploration method options, shown in Figure 25.
Select ATR Sites or Regional Defaults Using Filters

When *Select ATR sites or regional defaults using filters* is selected, the following form appears on the screen (Figure 26). At the top of the form, the user has the option to either *Explore ATR sites in the traffic library* or *Explore defaults in the traffic library*.

Explore ATR Sites in the Traffic Library

The form contains the following filters:

- County
- Functional Class
- TWRG Group
- Two-Way AADTT range (provide low AADTT and high AADTT for filtering)
- Total Lanes
The user may select any combination of filters. Once the filter selection is made, click the Apply Filters button to display the sites that match the selected criteria.

Remove button – Click the Remove button to remove the selected ATR sites from the MS traffic data library.

Once the user is satisfied with the selection, two options are available for viewing the selected site:

- View ATR Sites on a Map
- View Processed Data

View ATR Sites on a Map

The selected sites are displayed in red squares, along with various roads (Figure 27).

Show Sites by Functional Class – When this option is selected, the ATR sites are shown in different colors in accordance with the roadway functional classes where they reside.
Figure 27. Map of ATR Sites.

View Processed Data

Clicking on the View Processed Data button brings up the screen titled Show site specific traffic information. This screen has nine tabs across the top of the window as shown below in Figure 28. Click on a tab to view the various types of traffic characteristics available for the highlighted site.

Site Info Tab

The detailed report includes information about traffic site characteristics and traffic data availability. To see information for another traffic site, highlight that site in the box on the right-hand side of the screen.

Note that when default data are being explored, the Site Info tab information will be limited.
Veh. Class Tab

This tab presents the normalized vehicle class distribution in 10 FHWA truck class categories (Class 4 to 13) in a graphical form (Figure 29).
A normalized single axle load spectrum for all truck classes combined is plotted in this tab by default (Figure 30). The user can also choose to view the normalized single axle spectrum for individual truck classes by selecting the FHWA vehicle class from the drop-down box located at the lower left of the screen.
Figure 30. Normalized Single Axle Load Distribution.

Tandem Tab

Normalized tandem axle load spectrum is plotted in this tab, either for all the vehicle classes combined, or for each individual class Figure 31. The user can also choose to view the normalized tandem axle spectrum for individual truck classes by clicking the FHWA vehicle class at the lower left of the tab.
Figure 31. Normalized Tandem Axle Load Distribution.

Tridem Tab
Normalized tridem axle spectrum is plotted in this tab, either for all the vehicle classes combined, or for each individual class as shown in Figure 32. The user can choose to view the normalized tridem axle spectrum for individual truck classes by clicking the FHWA vehicle class at the lower left of the tab.
Figure 32. Normalized Tridem Axle Load Distribution.

Quad Tab
Similarly, normalized quad axle spectrum is plotted in this tab, either for all the vehicle classes combined, or for each individual class. The user can also choose to view the normalized quad axle spectrum for individual truck classes by clicking the FHWA vehicle class at the lower left of the tab. Currently, no sites in the library have information on quadruple axles. Therefore, no plot is shown for quadruple axle load spectrum.

Axle Coef Tab
The axle per class coefficients are displayed in table form under this tab as shown below in Figure 33.
Figure 33. Axle Coefficients.

**Monthly Adj. Tab**

The monthly truck volume adjustment factor is plotted and shown in Figure 34. The user can choose to view the monthly truck volume adjustment factor for all truck classes or for individual truck classes by clicking the FHWA vehicle class at the lower left of the tab.
Figure 34. Monthly Truck Volume Adjustment Factor.

Hourly Distr Tab

The hourly truck volume distribution factor is plotted in this tab and shown below in Figure 35.
Explore Defaults in the Traffic Library

In addition to exploring the ATR sites within the traffic library, the user can explore defaults within the traffic library. This option typically is chosen when specific site data are unavailable or nearby site traffic characteristics do not compare the site being analyzed. To begin exploring the data in the library, select the Explore defaults in the traffic library button on the form shown below in Figure 36.

Select a default category to explore and then press the Apply Filters button.
Once the filters are applied, the Apply Filters button becomes disabled. The user can select default traffic data from the list and explore the data using the View Processed Data tool.

The Remove button allows the user to remove the selected traffic default ID and its associated data from the program traffic data library.

Select ATR Sites using MS Map Exploration

To select a site or number of sites using the map selection tool, click on Select ATR sites from MS map for exploration, as shown in Figure 37.

Click on the Select Sections icon ( ) on the left-hand side of the screen to activate the selection tool. Use the selection tool to draw a rectangle on the map around the sections that the user wants to select. The color of selected sections changes to red. To make multiple selections, hold the Shift key while drawing rectangles. Once all reviews and updates are complete, press the Apply Selection button.

Show Road Func. Class frame provides the user with options to view roads with various functional classification. The user may click individual road functional classification to either display or hide the roads with the corresponding classification.
Figure 37. Select ATR Sites from Map.

Once the selections are applied, the user can explore the data using the *View Processed Data* tool.
GENERATE MEPDG INPUTS

This module, shown in Figure 38, enables the user to create traffic input files that are required by MEPDG software for new or rehabilitation pavement designs.

There are three options to start this module:
- Upon starting the MS-ATLAS program, the user may either click on the GENERATE MEPDG INPUTS tool and then click on the Start button, or
- During any session of the MS-ATLAS program, click the corresponding tool button, or
- Select the module from the Tools menu.

Create or Select a Project to Generate MEPDG Traffic Inputs

The user can either create a new project by entering new project information into the form, or select an existing project from the pull-down menu (Figure 39).
Figure 39. Create or Select a Project to Generate MEPDG Traffic Inputs.

To create a new project, enter the new project information into the Project Name and Description section of the form by overwriting the default information as shown below in Figure 40. Note that the project name should contain at most 25 characters.

Pavement Section Characteristics
Enter as much information as possible into the section of the form.

Traffic Inputs Analysis Status and Options
The following text boxes reflect the status of the traffic input analysis of the selected project:

- Last analysis option selection Date – If the user worked on this project previously, the date traffic analysis option was selected is displayed.
- Previously selected analysis ID – Displays previously select analysis ID, if any.
- Selected analysis Type – Displays previously select analysis type, if any. The analysis type could take one of the following values: “ATR Site” — A surrogate ATR station was used to generate traffic input files; “Regional Default” — A regional default was selected to generate traffic input files; “None” — No selection was made yet.
**Select Traffic Options** – The user has the following three options:

- Select a surrogate ATR station – Traffic characteristics from a processed ATR site will be selected and used in generating traffic input files.
- Select a regional traffic default – Traffic characteristics from a regional default in the traffic library will be selected and used in generating traffic input files.
- Use the previous selection – A selection was previously made and will be used.

![Figure 40. Create a New Project to Generate ME-PDG Inputs](image)

**Select a Traffic Station to Generate MEPDG Inputs**

The form contains the following filters:
- State Name
- Functional Class
- Total Number of Lanes
- County (site location)
- TWRG Group
- Two-Way AADTT range

The user may select any combination of criteria in order to find the best suitable site for the project. Once the filter selection is made, click on the Apply Filters button to find the sites that match the selected criteria in the traffic data library, as shown in Figure 41.

![Select a Traffic Station to Generate ME-PDG Inputs](image)

Once satisfied with the available sites, select the traffic site to be used by clicking on the site ID number. Click the Next button to view the traffic characteristics of the selected site.

Figure 41. Select a Surrogate ATR Station to Generate MEPDG Inputs.
Select a Regional Traffic Default

In lieu of using an ATR site, the user may select a regional traffic default by clicking the Select a regional traffic default radio button and then using the pull-down menu to the right to select one of the default traffic sites, as shown in Figure 42.

Figure 42. Select a Regional Traffic Default to Generate ME-PDG Inputs.

Once satisfied with the regional traffic default selection, click the Next button to view the traffic characteristics of the selected site.

View Traffic Characteristics and Generate MEPDG Inputs

Traffic characteristics of the selected ATR site or regional traffic defaults are displayed in this form, consisting of 9 tabs. The selected ATR site ID or the regional default ID is displayed at the top of the form.

Click on one of the tabs across the top of the window to view the various types of traffic characteristics available.
Site Info Tab

The Site Info tab, shown in Figure 43, includes information about traffic site characteristics and historic traffic data availability. When a default traffic ID is selected, some of the information under the Site Info tab is blank, as illustrated in Figure 44.

![Traffic characteristics of the selected ATR site or default](image)

Figure 43. Specific ATR Site Information
**Veh. Class Tab**

This table presents the normalized vehicle class distribution in 10 FHWA truck class categories (Class 4 to 13) for the surrogate site in a graphical form, as shown in Figure 45.
Single Tab
By default, a normalized single axle load spectrum for all truck classes combined at the surrogate site is plotted in this tab, as illustrated in Figure 46. The user can also choose to view the normalized single axle spectrum for individual truck classes by selecting the FHWA vehicle class from the drop-down box at the lower left of the screen. The FHWA Class 9 single axle load spectrum is shown below.
Tandem Tab

Normalized tandem axle load spectrum for the surrogate site is plotted in this tab. The user can also choose to view the normalized tandem axle spectrum for individual truck classes by clicking the FHWA vehicle class at the lower left of the tab.

Tridem Tab

Normalized tridem axle spectrum for the surrogate site is plotted in this tab. The user can also choose to view the normalized tridem axle spectrum for individual truck classes by clicking the FHWA vehicle class at the lower left of the tab.
Quad Tab
Normalized quad axle spectrum for the surrogate site is plotted in this tab. The user can also choose to view the normalized quad axle spectrum for individual truck classes by clicking the FHWA vehicle class at the lower left of the tab. Currently, no sites in the library have information on quadruple axles.

Axle Coef Tab
The axle per class coefficients for the selected traffic site are displayed in table form under this tab.

Monthly Adj. Tab
The monthly truck volume adjustment factor is plotted in this tab. The user can choose to view the monthly truck volume adjustment factor for all truck classes or for individual truck classes by clicking the FHWA vehicle class at the lower left of the tab.

Hourly Distr Tab
The hourly truck volume distribution factor for the selected traffic site is plotted in this tab.

When the user finishes exploring the traffic characteristics for the surrogate site, click the Next button to move to the Establish Base Year Truck Volume and Growth screen.

Establish Base Year Truck Volume and Growth
This is a key step in generating MEPDG traffic input files. The default information in the Establish Base Year Truck Volume and Growth form should be modified carefully to reflect the specific pavement design project that the inputs are being generated for. For example, a linear growth function with a growth rate of 4% is selected for the project site by default. If the user knows that the growth function or rate at the project site is different than the default value, then the Select growth function and rates section of the form should be altered accordingly.

When a surrogate ATR site is selected the AADTT values recorded, along with the recording years, are displayed.

The traffic open year and month correspond to the first month and year that the new project will be open to traffic.

Once all updates are made to the form shown in Figure 47, click the Plot/Refresh button to view the projected AADTT.
Figure 47. Establish Base Year Truck Volume and Growth.

Once all of the information on the form has been reviewed and the new computed design lane AADT has been observed, click the Update/Record button to store the information. Click the Next button to move to the next step.

**View Estimated ESALs and Generate MEPDG Input Files**

This is the last step in generating traffic input files for design a segment of pavement. Based on the information provided, the program automatically computes estimated cumulative ESALs for a standard pavement structure, for flexible pavement and rigid pavement, respectively.
Figure 48. View ESALs and Generate MEPDG Input Files.

Figure 48, above, allows the user to review ESAL information based on the user-defined pavement structure. If the AC SN or the PCC depth values are known, they can be updated by overwriting the default value in the corresponding text boxes. Once all updates are made, click the Re-compute ESALs button to view the updated ESALs.

Click Generate MEPDG Inputs to create input files required by the MEPDG software. If successful, MS-ATLAS shows the directory where the created input files are stored. The user may visit the directory listed in the message box to view the MEPDG input files for this analysis.